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1 HPDesklJet 2130 series Help

Learn how to use your HP DeskJet 2130 series.

° Get started on page 3

° Print on page 21

° Copy and scan on page 31

° Manage ink cartridges on page 37

° Connect your printer on page 45

° Technical information on page 69

° Solve a problem on page 49
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Get started

° Printer parts

° Control panel features

e  Status lights

° Load media

° Load an original on the scanner glass

° Paper basics

e  Open the HP printer software (Windows)

° Sleep mode
e  Auto-Off
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Printer parts

O 006

Paper-width guide

2 Input tray

3 Input tray shield

) Scanner lid

5 Scanner glass

6 Control panel

7 Cartridge access door
8 Ink cartridges

9 Output tray

10 Output tray extender (also referred to as the tray extender)
1 Power connection

12 USB port

Chapter 2 Get started
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Control panel features
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Feature Description

1 Cancel button: Stops the current operation.

2 Resume button: Resumes a job after a disruption (for example, after loading paper or clearing a
paper jam).

Resume light: Indicates the printer is in a warning or error state.

3 Start Copy Black button: Starts a black-and-white copy job. To increase the number of black-and-
white copies, press the button multiple times. Copying will start two seconds after the last button
press.

q Start Copy Color button: Starts a color copy job. To increase the number of color copies, press the
button multiple times. Copying will start two seconds after the last button press.

5 Power button: Turns the printer on or off.

6 Ink Alert lights: Indicates low ink or an ink cartridge problem.

Control panel features
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Status lights

Power button light
@
:—J
Status Description
On The printer is on.
Off The printer is powered off.
Dimmed Indicates the printer is in Sleep mode. The printer automatically enters Sleep mode after 5
minutes of inactivity.
Blinking The printer is processing a job. To cancel the job, press the Cancel button (X ).
Fast blinking If the cartridge access door is open, close it. If the cartridge access door is closed and the light

is fast blinking, the printer is in an error state that you can resolve by following the on-screen
messages from the computer. If you do not see any on-screen messages, try printing a
document to generate an on-screen message.

The Resume light is blinking.

()

Cause

Solution

There is no paper in the input tray.

Load paper in the input tray, and then press the Resume
button (m) to continue printing. For information about how

to load paper, see Load media on page 10.

The Resume light is off and one Ink Alert light is on.

-

Cause

Solution

One of the following might have occurred.

—  The corresponding ink cartridge is missing.

— The corresponding ink cartridge is installed improperly,

or still has plastic tape on it.

— The corresponding ink cartridge is low on ink.

— If one of the ink cartridges is missing, the printer enters
the single-cartridge mode. To exit the single-cartridge
mode, insert the corresponding ink cartridge. For more
information about the single-cartridge mode, see Use
single-cartridge mode on page 42.

— If both ink cartridges are installed in the printer, remove
the corresponding ink cartridge, make sure there is no
plastic tape on it, and then reinsert the ink cartridge
securely. For more information, see Replace ink
cartridges on page 40.

— If theink cartridge is low on ink, the printer can continue
to print using the remaining ink. The quality of printed
documents might be affected. Replace the ink cartridge
when the print quality is no longer acceptable. For more
information, see Replace ink cartridges on page 40.

Chapter 2 Get started
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e  The Resume light is off and both Ink Alert lights are on.
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Cause Solution

Both ink cartridges are low on ink. The printer can continue to print using the remaining ink. The
quality of printed documents might be affected. Replace the
ink cartridges when the print quality is no longer acceptable.
For information about how to replace ink cartridges, see
Replace ink cartridges on page 40.

e  The Resume light is off and one Ink Alert light is blinking.

p
+ & -/(\ s e
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Cause Solution
The corresponding ink cartridge is incompatible, damaged,or —  Make sure that you are using the correct HP ink cartridge
incorrectly installed. for your printer.

— Make sure the corresponding ink cartridge is installed in
the correct slot.

— If the error persists, replace the ink cartridge. For
information about how to replace ink cartridges, see
Replace ink cartridges on page 40.

e  The Resume light is off and both Ink Alert lights are blinking.

)+ o

Cause Solution

One of the following might have occurred. — If thereis no ink cartridge installed in the printer, install

the ink cartridges.
— Bothink cartridges are missing.

— If bothink cartridges are installed in the printer, remove

— Bothink cartridges are installed improperly, or still have the cartridges, make sure there is no plastic tape on
plastic tape on them. them, and then reinsert the ink cartridges securely.
— Bothink cartridges are incompatible or damaged. —  Make sure that you are using the correct HP ink

cartridges for your printer.

— If the error persists, replace the ink cartridges. For
information about how to replace ink cartridges, see
Replace ink cartridges on page 40.

e  The Resume light is blinking and one Ink Alert light is on.

ENWW Status lights
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Cause Solution

One of the following might have occurred. — If the corresponding ink cartridge is newly installed, it
might be counterfeit or previously used. Refer to the

— A counterfeit or previously used ink cartridge is installed. message in your HP printer software for more
information.

— The corresponding ink cartridge is very low on ink.
— If the corresponding ink cartridge is not newly installed,

it is very low on ink. Press the Resume button (m) to

continue printing, and replace the ink cartridge when the
print quality is no longer acceptable. For information
about how to replace ink cartridges, see Replace ink
cartridges on page 40.

The Resume light is blinking and both Ink Alert lights are on.

Cause Solution
One of the following might have occurred. — If the ink cartridges are newly installed, they might be
counterfeit or previously used. Refer to the message in
— The counterfeit or previously used ink cartridges are the HP printer software for more information.
installed.

— If theink cartridges are not newly installed, they are very
— Both of the ink cartridges are very low on ink. . .
low on ink. Press the Resume button (@) to continue
printing, and replace the ink cartridges when the print
quality is no longer acceptable. For information about
how to replace ink cartridges, see Replace ink cartridges
on page 40.

The Resume light is blinking, the Power button light is on, and both Ink Alert lights are blinking.

OIS E

FH

Cause Solution

One of the following might have occurred. Clear paper jams or carriage jams if any. For more information,
see Jams and paper-feed issues on page 50.

— Thereis a paper jam.

— The cartridge carriage inside the printer has stalled.

The Resume light, the Power button light, and both Ink Alert lights are blinking.

@+ %9+# ¢
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Cause

Solution

One of the following might have occurred.

The scanner is not working.

The printer is in an error state.

Reset the printer.

1. Turn off the printer.

2.  Unplug the power cord.

3. Wait a minute, and then plug the power cord back in.
4. Turnon the printer.

If the problem persists, contact HP. The printer can still print
even if the scanner is not working.

Status lights
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Load media

Select a paper size to continue.

To load full-size paper

1. Raise the input tray.

2.  Slide the paper-width guide to the left.

3. Insert a stack of paper into the input tray with the short edge down and the print side up, and slide the
stack of paper down until it stops.

=
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4. Slide the paper-width guide to the right until it stops at the edge of the paper.

5. Lower the output tray and pull out the output tray extender.

To load small-size paper

1. Raise the input tray.

2. Slide the paper-width guide to the left.

ENWW Load media 11



3. Insert a stack of photo paper into the far-right side of the input tray with the short edge down and the
print side up, and slide the stack of paper down until it stops.

4. Slide the paper-width guide to the right until it stops at the edge of the paper.

5. Lower the output tray and pull out the output tray extender.

To load envelopes

1. Raise the input tray.

12 Chapter 2 Get started ENWW
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Slide the paper-width guide to the left.

Insert one or more envelopes into the far-right side of the input tray and slide the stack of envelopes
down until it stops.

The side to be printed on should face up. The flap should be on the left side and facing down.

Slide the paper-width guide to the right against the stack of envelopes until it stops.

Lower the output tray and pull out the output tray extender.

Load media

13



Load an original on the scanner glass

To load an original on the scanner glass

1.  Lift the scanner lid.

=
T

2. Load the original print-side down on the right corner of the scanner glass.

3. Close the scanner lid.

14 Chapter2 Get started ENWW



Paper basics

The printer is designed to work well with most types of office paper. It is best to test a variety of print paper
types before buying large quantities. Use HP paper for optimum print quality. Visit the HP website at
www.hp.com for more information about HP paper.

HP recommends plain papers with the ColorLok logo for printing everyday documents. All
papers with the ColorLok logo are independently tested to meet high standards of
reliability and print quality, and produce documents with crisp, vivid color, bolder blacks,
and that dry faster than ordinary plain papers. Look for papers with the ColorLok logo in
a variety of weights and sizes from major paper manufacturers.

This section contains the following topics:

° Recommended papers for printing

° Order HP paper supplies

Recommended papers for printing

If you want the best print quality, HP recommends using HP papers that are specifically designed for the type
of project you are printing.

Depending on your country/region, some of these papers might not be available.

Photo printing
e  HP Premium Plus Photo Paper

HP Premium Plus Photo Paper is HP’s highest-quality photo paper for your best photos. With HP
Premium Plus Photo Paper, you can print beautiful photos that are instant-dry so you can share them
right off the printer. It is available in several sizes, including A4, 8.5 x 11 inches, 4 x 6 inches (10 x 15
cm), 5 x 7 inches (13 x 18 cm), and in two finishes - glossy or soft gloss (semi-gloss). Ideal for framing,
displaying, or gifting your best photos and special photo projects. HP Premium Plus Photo Paper delivers
exceptional results with professional quality and durability.

e  HP Advanced Photo Paper

This glossy photo paper features an instant-dry finish for easy handling without smudging. It resists
water, smears, fingerprints, and humidity. Your prints have a look and feel comparable to a store-
processed photo. It is available in several sizes, including A4, 8.5 x 11 inches, 10 x 15 cm (4 x 6 inches),
13 x 18 cm (5 x 7 inches). It is acid-free for longer lasting documents.

e  HP Everyday Photo Paper

Print colorful, everyday snapshots at a low cost, using paper designed for casual photo printing. This
affordable photo paper dries quickly for easy handling. Get sharp, crisp images when you use this paper
with any inkjet printer. It is available in glossy finish in several sizes, including A4, 8.5 x 11 inches, 5 x 7
inches, and 4 x 6 inches (10 x 15 cm). It is acid-free for longer lasting documents.

° HP Photo Value Packs

HP Photo Value Packs conveniently package original HP ink cartridges and HP Advanced Photo Paper to
save you time and take the guesswork out of printing affordable, lab-quality photos with your HP

ENWW Paper basics 15
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printer. Original HP inks and HP Advanced Photo Paper have been designed to work together so your
photos are long lasting and vivid, print after print. Great for printing out an entire vacation's worth of
photos or multiple prints to share.

Business documents

HP Premium Presentation Paper 120g Matte or HP Professional Paper 120 Matt

This paper is a heavy two-sided matte paper perfect for presentation, proposals, reports, and
newsletters. It is heavyweight for an impressive look and feel.

HP Brochure Paper 180g Glossy or HP Professional Paper 180 Glossy

These papers are glossy-coated on both sides for two-sided use. They are the perfect choice for near-
photographic reproductions and business graphics for report covers, special presentations, brochures,
mailers, and calendars.

HP Brochure Paper 180g Matte or HP Professional Paper 180 Matte

These papers are matte-coated on both sides for two-sided use. They are the perfect choice for near-
photographic reproductions and business graphics for report covers, special presentations, brochures,
mailers, and calendars.

Everyday printing

All the papers listed for everyday printing feature ColorLok Technology for less smearing, bolder blacks, and
vivid colors.

HP Bright White Inkjet Paper

HP Bright White Inkjet Paper delivers high-contrast colors and sharp text. It is opaque enough for two-
sided color usage with no show-through, which makes it ideal for newsletters, reports, and flyers.

HP Printing Paper

HP Printing Paper is a high-quality multifunction paper. It produces documents that look and feel more
substantial than documents printed on standard multipurpose or copy paper. It is acid-free for longer
lasting documents.

HP Office Paper

HP Office Paper is a high-quality multifunction paper. It is suitable for copies, drafts, memos, and other
everyday documents. It is acid-free for longer lasting documents.

HP Office Recycled Paper

HP Office Recycled Paper is a high-quality multifunction paper made with 30% recycled fiber.

Order HP paper supplies

The printer is designed to work well with most types of office paper. Use HP paper for optimum print quality.

To order HP papers and other supplies, go to www.hp.com . At this time, some portions of the HP website are
available in English only.

HP recommends plain papers with the ColorLok logo for printing and copying of everyday documents. All
papers with the ColorLok logo are independently tested to meet high standards of reliability and print quality,
and produce documents with crisp, vivid color, bolder blacks and shorter dry-time than ordinary plain papers.
Look for papers with the ColorLok logo in a variety of weights and sizes from major paper manufacturers.

Chapter 2 Get started ENWW
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Open the HP printer software (Windows)

After installing the HP printer software, double-click the printer icon on the desktop or do one of the following
to open the printer software:

e  Windows 8.1: Click the down arrow in lower left corner of the Start screen, and then select the printer
name.

e  Windows 8: Right-click an empty area on the Start screen, click AL Apps on the app bar, and then select
the printer name.

e  Windows 7, Windows Vista, and Windows XP: From the computer desktop, click Start, select All
Programs, click HP, click the folder for the printer, and then select the icon with the printer's name.

ENWW Open the HP printer software (Windows) 17



Sleep mode
e  Power usage is reduced while in Sleep mode.
e  Afterinitial setup of printer, the printer will enter Sleep mode after 5 minutes of inactivity.
e  The Power button light is dimmed in Sleep mode.

e  Thetime to Sleep mode cannot be changed.

18 Chapter 2 Get started ENWW



Auto-0ff

ENWW

This feature turns the printer off after 2 hours of inactivity to help reduce energy use. Auto-0ff turns the
printer off completely, so you must use the Power button to turn the printer back on. If your printer
supports this energy saving feature, Auto-0ff is automatically enabled or disabled depending on printer
capabilities and connection options. Even when Auto-Off is disabled, the printer enters Sleep mode after 5
minutes of inactivity to help reduce energy use.

e  Auto-Off is enabled when the printer is turned on, if the printer does not have network or fax capability,
or is not using these capabilities.

e  Auto-Off is disabled when a printer’s wireless or Wi-Fi Direct capability is turned on or when a printer
with fax, USB, or Ethernet network capability establishes a fax, USB, or Ethernet network connection.

Auto-Off

19
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Print

° Print documents

° Print photos
e  Print envelopes

° Print using the maximum dpi

° Tips for print success
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Print documents

Before printing documents, make sure you have paper loaded in the input tray and the output tray is open.
For more information about loading paper, see Load media on page 10.

To print a document (Windows)
1.  From your software, select Print.
2. Make sure your printer is selected.
3.  Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties, Options, Printer Setup,
Printer Properties, Printer, or Preferences.

4. Select the appropriate options.
e  Onthe Layout tab, select Portrait or Landscape orientation.

e  Onthe Paper/Quality tab, select the appropriate paper type from the Media drop-down list in the
Tray Selection area, select the appropriate print quality in the Quality Settings area, and then
select the appropriate color in the Color area.

o  C(lick Advanced to select the appropriate paper size from the Paper Size drop-down list.
5. Click OK to close the Properties dialog box.

6.  Click Print or OK to begin printing.

To print documents (0S X)
1. From the File menu in your software, choose Print.
2. Make sure your printer is selected.
3. Specify the page properties.

If you do not see options on the Print dialog, click Show Details.

A,

E NOTE: The following options are available for a USB connected printer. Locations for the options can
vary from one application to another.

e  (Choose the paper size.

[’_5”? NOTE: If you change the Paper Size ensure that you have loaded the correct paper.

e  Select the orientation.
e  Enter the scaling percentage.

4. Click Print.

To print on both sides of the page (Windows)
1.  From your software, select Print.

2. Make sure your printer is selected.

22 Chapter3 Print ENWW



Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties, Options, Printer Setup,
Printer Properties, Printer, or Preferences.

Select the appropriate options.
e  Onthe Layout tab, select Portrait or Landscape orientation.

e  Onthe Paper/Quality tab, select the appropriate paper type from the Media drop-down list in the
Tray Selection area, select the appropriate print quality in the Quality Settings area, and then
select the appropriate color in the Color area.

e  C(lick Advanced to select the appropriate paper size from the Paper Size drop-down list.
On the Layout tab, select an appropriate option from the Print on Both Sides Manually drop-down list.

After you print the first side, follow the on-screen instructions to reload the paper with the blank side up
and top of the page down, and then click Continue.

Click OK to print.

To print on both sides of the page (0S X)

ENWW

1.

2.

From the File menu in your software, choose Print.

In the Print dialog, choose Paper Handling from the pop-up menu and set Page Order to Normal.
Set Pages to Print to 0dd only.

Click Print.

After all of the odd numbered pages have printed, remove the document from the output tray.

Reload the document so that the end that came out of the printer is now going into the printer and the
blank side of the document is facing toward the front of the printer.

In the Print dialog, return to the Paper Handling pop-up menu and set the page order to Normal and the
pages to print to Even Only.

Click Print.

Print documents

23



Print photos

Before printing photos, make sure you have photo paper loaded in the input tray and the output tray is open.
For more information about loading paper, see Load media on page 10.

To print a photo on photo paper (Windows)
1.  From your software, select Print.
2. Make sure your printer is selected.
3.  Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties, Options, Printer Setup,
Printer Properties, Printer, or Preferences.

4. Select the appropriate options.
e  Onthe Layout tab, select Portrait or Landscape orientation.

e  Onthe Paper/Quality tab, select the appropriate paper type from the Media drop-down list in the
Tray Selection area, select the appropriate print quality in the Quality Settings area, and then
select the appropriate color in the Color area.

o  C(lick Advanced to select the appropriate photo size from the Paper Size drop-down list.
5.  Click OK to return to the Properties dialog box.

6. Click OK, and then click Print or OK in the Print dialog box.

[%r NOTE: After the printing is finished, remove unused photo paper from the input tray. Store the photo paper
so it does not start to curl, which could reduce the quality of your printout.

To print a photo from the computer (0S X)
1. From the File menu in your software, choose Print.
2. Make sure your printer is selected.
3. Set the print options.

If you do not see options on the Print dialog, click Show Details.

[%f NOTE: The following options are available for a USB connected printer. Locations for the options can
vary from one application to another.

a. Choose the appropriate paper size in the Paper Size pop-up menu.

'L%y NOTE: If you change the Paper Size ensure that you have loaded the correct paper.

b. Select an Orientation.

¢.  From the pop-up menu, choose Paper Type/Quality, and then choose the following settings:

24  Chapter 3 Print ENWW



e  Paper Type: The appropriate photo paper type
e  Quality: Best or Maximum dpi

e  (lick the Color Options disclosure triangle, and then choose the appropriate Photo Fix
option.

—  Off: applies no changes to the image.
— Basic: automatically focuses the image; moderately adjusts image sharpness.

4. Select any other print settings you want, and then click Print.

ENWW Print photos 25



Print envelopes

Before printing envelopes, make sure you have envelopes loaded in the input tray and the output tray is open.
You can load one or more envelopes into the input tray. Do not use shiny or embossed envelopes or envelopes
that have clasps or windows. For more information about loading envelopes, see Load media on page 10.

[%?9 NOTE: For specific details on how to format text for printing on envelopes, consult the help files in your
word application.

To print an envelope (Windows)
1.  From your software, select Print.
2. Make sure your printer is selected.
3. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties, Options, Printer Setup,
Printer Properties, Printer, or Preferences.

4. Select the appropriate options.
e  Onthe Layout tab, select Portrait or Landscape orientation.

e  Onthe Paper/Quality tab, select the appropriate paper type from the Media drop-down list in the
Tray Selection area, select the appropriate print quality in the Quality Settings area, and then
select the appropriate color in the Color area.

o  C(lick Advanced to select the appropriate envelope size from the Paper Size drop-down list.

5. Click OK, and then click Print or OK in the Print dialog box.

To print envelopes (0S X)
1. From the File menu in your software, choose Print.
2. Make sure your printer is selected.
3. Set the print options.

If you do not see options on the Print dialog, click Show Details.

[1?? NOTE: The following options are available for a USB connected printer. Locations for the options can
vary from one application to another.

a. Select the appropriate envelope size from the Paper Size pop-up menu.

[’_5{ NOTE: If you change the Paper Size ensure that you have loaded the correct paper.

b. From the pop-up menu, choose Paper Type/Quality, and verify the paper type setting is set to
Plain Paper.

4. Click Print.
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Print using the maximum dpi

Use maximum dots per inch (dpi) to print high-quality, sharp images on photo paper.

Printing in maximum dpi takes longer than printing with other settings and requires a large amount of disk
space.

For a list of supported print resolutions, visit the HP DeskJet 2130 series support website at www.hp.com/
support.

To print in maximum dpi mode (Windows)
1.  Fromyour software, select Print.
2. Make sure your printer is selected.
3.  Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties, Options, Printer Setup,
Printer Properties, Printer, or Preferences.

4. Click the Paper/Quality tab.

5. From the Media drop-down list, select an appropriate paper type.

6. Click the Advanced button.

7. Inthe Printer Features area, select Yes from the Print in Max DPI drop-down list.
8. Select the appropriate paper size from the Paper Size drop-down list.

9. Click OK to close the advanced options.

10. Confirm Orientation on the Layout tab, and then click OK to print.

To print using maximum dpi (0S X)
1. From the File menu in your software, choose Print.
2. Make sure your printer is selected.
3. Setthe print options.

If you do not see options on the Print dialog, click Show Details.

[%”r NOTE: The following options are available for a USB connected printer. Locations for the options can
vary from one application to another.

a. Choose the appropriate paper size in the Paper Size pop-up menu.

[17? NOTE: If you change the Paper Size ensure that you have loaded the correct paper.

b. From the pop-up menu, choose Paper Type/Quality, and then choose the following settings:
e  Paper Type: The appropriate paper type
e  Quality: Maximum dpi

4. Select any other print settings that you want, and then click Print.
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Tips for print success

To print successfully, the HP ink cartridges should be functioning properly with sufficient ink, the paper should
be loaded correctly, and the printer should have the appropriate settings.

Print settings do not apply to copying or scanning.

Ink tips
e  Use original HP ink cartridges.
e Install both the black and tri-color cartridges correctly.

For more information, see Replace ink cartridges on page 40.

e  (Check the estimated ink levels in the ink cartridges to make sure there is sufficient ink.

For more information, see Check estimated ink levels on page 38.

e [f the print quality is not acceptable, see Printing issues on page 56 for more information.

Paper loading tips

e  Load astack of paper (not just one page). All of the paper in the stack should be in the same size and
type to avoid a paper jam.

e  Load the paper with side to be printed on facing up.
e  Ensure that paper loaded in the input tray lays flat, and the edges are not bent or torn.

e  Adjust the paper-width guide in the input tray to fit snugly against all paper. Make sure the paper-width
guide does not bend the paper in the input tray.

For more information, see Load media on page 10.

Printer settings tips (Windows)

e  To change default print settings, open the HP printer software, click Print & Scan, and then click Set
Preferences. For information how to open the printer software, see Open the HP printer software
(Windows) on page 17.

e  Toselect the number of pages to print per sheet, on the Layout tab, select the appropriate option from
the Pages per Sheet drop-down list.

e  To view more printing settings, on the Layout or Paper/Quality tab, click the Advanced button to open
the Advanced Options dialog box.

— Printin Grayscale: Allows you to print a black and white document using the black ink only. Select
Black Ink Only, and then click OK . It also allows you to print a high quality black and white image.
Select High Quality Grayscale, and then click OK .

— Pages per Sheet Layout: Helps you specify the order of the pages if you print the document with
more than two pages per sheet.

[%”r NOTE: The preview on the Layout tab cannot reflect what you select from the Pages per Sheet
Layout drop-down list.

— HP Real Life Technologies: This feature smooths and sharpens images and graphics for improved
print quality.
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— Booklet: Allows you to print a multiple-page document as a booklet. It places two pages on each
side of a sheet that can then be folded into a booklet in half size of the paper. Select a binding
method from the drop-down list, and then click OK.

o  Booklet-LeftBinding: The binding side after folded into a booklet appears at the left side.
Select the option if your reading habit is from left to right.

o  Booklet-RightBinding: The binding side after folded into a booklet appears at the right side.
Select the option if your reading habit is from right to left.

¥ NOTE: The preview on the Layout tab cannot reflect what you select from the Booklet drop-
down list.

— Pages to Print: Allows you to print the odd pages only, print the even pages only, or print all pages.

— PageBorders: Allows you to add borders to the pages if you print the document with two or more
pages per sheet.

¥ NOTE: The preview on the Layout tab cannot reflect what you select from the Page Borders
drop-down list.

You can use printing shortcut to save time setting printing preferences. A printing shortcut stores the
setting values that are appropriate for a particular kind of job, so that you can set all the options with a
single click. To use it, go to the Printing Shortcut tab, select one printing shortcut, and then click OK.

To add a new printing shortcut, after making settings on the Layout or Paper/Quality tab, click the
Printing Shortcut tab, click Save As and enter a name, and then click OK.

To delete a printing shortcut, select it, and then click Delete.

E/f NOTE: You cannot delete the default printing shortcuts.

Printer settings tips (0S X)

ENWW

On the Print dialog, use the Paper Size pop-up menu to select the size of paper loaded in the printer.

On the Print dialog, choose the Paper Type/Quality pop-up menu and select the appropriate paper type
and quality.

To print a black and white document using only black ink, choose the Paper Type/Quality from the pop-
up menu and choose Grayscale from the Color pop-up menu.

Tips for print success
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Notes

e  Original HP ink cartridges are designed and tested with HP printers and papers to help you easily
produce great results, time after time.

[1?? NOTE: HP cannot guarantee the quality or reliability of non-HP supplies. Product service or repairs
required as a result of using a non-HP supply will not be covered under warranty.

If you believe the purchased original HP ink cartridges, go to:

www.hp.com/go/anticounterfeit

e Inklevel warnings and indicators provide estimates for planning purposes only.

[%f NOTE: When you receive a low-ink warning message, consider having a replacement ink cartridge
available to avoid possible printing delays. You do not need to replace the ink cartridges until the print
quality becomes unacceptable.

e  You can print your document on both sides of the paper manually.
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Copy and scan

° Copy documents

° Scan

e Tips for copy and scan success

31



Copy documents

[%’/r NOTE: All documents are copied in normal quality print mode. You cannot change the print mode quality
when copying.

To copy documents
1. Load paper in the input tray.

For information about how to load paper, see Load media on page 10.

2. Load the original print side down on the right front corner of the scanner glass.

For more information, see Load an original on the scanner glass on page 14.

3. Press either the Start Copy Black button (O) or the Start Copy Color button (:-::D) to make a copy.

Copying will start two seconds after the last button press.

¥ TIP: You can increase the number of copies by pressing the button multiple times.
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Scan

° Scan to a computer

e  (reate a new scan shortcut (Windows)

° Change scan settings (Windows)

Scan to a computer

Before scanning to a computer, make sure you have already installed the HP recommended printer software.
The printer and computer must be connected and turned on.

To scan a document or photo to a file (Windows)
1. Load the original print side down on the right front corner of the scanner glass.
2. Double-click the printer icon on the desktop or do one of the following to open the printer software:

e  Windows 8.1: Click the down arrow in lower left corner of the Start screen, and then select the
printer name.

e  Windows 8: Right-click an empty area on the Start screen, click All Apps on the app bar, and then
select the printer name.

e  Windows 7, Windows Vista, and Windows XP: From the computer desktop, click Start, select All
Programs, click HP, click the folder for the printer, and then select the icon with the printer's name.

3. Inthe printer software, click Scan a Document or Photo .
4. Select the type of scan you want and then click Scan .
e  Choose Save as PDF to save the document (or photo) as a PDF file.

e  Choose Save as JPEG to save the photo (or document) as an image file.

[’_5”? NOTE: Click the More link at the top right corner of the Scan dialog to review and modify settings for
any scan.

For more information, see Change scan settings (Windows) on page 35.

If Show Viewer After Scan is selected, you can make adjustments to the scanned image in the preview
screen.

To scan a document or photo to email (Windows)
1. Load the original print side down on the right front corner of the scanner glass.
2. Double-click the printer icon on the desktop or do one of the following to open the printer software:

° Windows 8.1: Click the down arrow in lower left corner of the Start screen, and then select the
printer name.

e  Windows 8: Right-click an empty area on the Start screen, click All Apps on the app bar, and then
select the printer name.

e  Windows 7, Windows Vista, and Windows XP: From the computer desktop, click Start, select All
Programs, click HP, click the folder for the printer, and then select the icon with the printer's name.
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3. Inthe printer software, click Scan a Document or Photo .
4. Select the type of scan you want and then click Scan..

Choose Email as PDF or Email as JPEG to open your email software with the scanned file as an
attachment.

[%f NOTE: Click the More link at the top right corner of the Scan dialog to review and modify settings for
any scan.

For more information, see Change scan settings (Windows) on page 35.

If Show Viewer After Scan is selected, you can make adjustments to the scanned image in the preview
screen.

To scan an original from HP printer software (0S X)
1. OpenHP Scan.
HP Scan is located in the Applications/Hewlett-Packard folder at the top level of the hard disk.
2. Click Scan.

3. Choose the type of scan profile you want and follow the on-screen instructions.

Create a new scan shortcut (Windows)

You can create your own scan shortcut to make scanning easier. For example, you might want to regularly
scan and save photos in PNG format, rather than JPEG.

1. Load the original print side down on the right front corner of the scanner glass.
2. Double-click the printer icon on the desktop or do one of the following to open the printer software:

° Windows 8.1: Click the down arrow in lower left corner of the Start screen, and then select the
printer name.

o  Windows 8: Right-click an empty area on the Start screen, click All Apps on the app bar, and then
select the printer name.

e  Windows 7, Windows Vista, and Windows XP: From the computer desktop, click Start, select All
Programs, click HP, click the folder for the printer, and then select the icon with the printer's name.

3. Inthe printer software, click Scan a Document or Photo .
4. Click Create New Scan Shortcut.

5. Enter a descriptive name, choose an existing shortcut on which to base your new shortcut, and then click
Create.

For example, if you are creating a new shortcut for photos, choose either Save as JPEG or Email as
JPEG . This makes available the options for working with graphics when scanning.

6. Change the settings for your new shortcut to meet your needs, and then click the save icon to the right
of the shortcut.
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)L%f NOTE: Click the More link at the top right corner of the Scan dialog to review and modify settings for

any scan.

For more information, see Change scan settings (Windows) on page 35.

Change scan settings (Windows)

ENWW

You can modify any of the scan settings either for a singular use or save the changes to use permanently.
These settings include options such as page size and orientation, scan resolution, contrast, and the folder
location for saved scans.

1.

2.

Load the original print side down on the right front corner of the scanner glass.
Double-click the printer icon on the desktop or do one of the following to open the printer software:

° Windows 8.1: Click the down arrow in lower left corner of the Start screen, and then select the
printer name.

e  Windows 8: Right-click an empty area on the Start screen, click All Apps on the app bar, and then
select the printer name.

e  Windows 7, Windows Vista, and Windows XP: From the computer desktop, click Start, select All
Programs, click HP, click the folder for the printer, and then select the icon with the printer's name.

In the printer software, click Scan a Document or Photo .
Click the More link in the top right corner of the HP Scan dialog.

The detailed settings pane appears on the right. The left column summarizes the current settings for
each section. The right column allows you to change the settings in the highlighted section.

Click each section at the left of the detailed settings pane to review the settings in that section.
You can review and change most settings using drop-down menus.

Some settings allow greater flexibility by displaying a new pane. These are indicated by a + (plus sign) at
the right of the setting. You must either accept or cancel any changes on this pane to return to the
detailed settings pane.

When you have finished changing settings, do one of the following.

e C(lick Scan. You are prompted to save or reject the changes to the shortcut after the scan is
finished.

e  (lick the save icon to the right of the shortcut, and then click Scan ..

Scan
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Tips for copy and scan success

Use the following tips to copy and scan successfully:

e  Keep the glass and the back of the lid clean. The scanner interprets anything it detects on the glass as
part of the image.

e  Load your original, print side down, on the right front corner of the glass.

e  Tomake a large copy of a small original, scan the original into the computer, resize the image in the
scanning software, and then print a copy of the enlarged image.

e  Toavoid incorrect or missing scanned text, make sure the brightness is set appropriately in the
software.
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5 Manage ink cartridges

This section contains the following topics:

° Check estimated ink levels

° Order ink supplies

° Replace ink cartridges

° Use single-cartridge mode

° Cartridge warranty information

e Tips for working with cartridges
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Check estimated ink levels

You can easily check the ink supply level to determine how soon you might need to replace an ink cartridge.
The ink supply level shows an estimate of the amount of ink remaining in the ink cartridges.

To check the ink levels from the HP printer software (Windows)

1.  Open the HP printer software. For more information, see Open the HP printer software (Windows)
on page 17.

2. Inthe printer software, click the Estimated Ink Levels tab.

To check the ink levels from the HP printer software (0S X)
1.  Open HP Utility.

HP Utility is located in the Hewlett-Packard folder in the Applications folder at the top level of the hard
disk.

2. Select the HP DeskJet 2130 series from the list of devices at the left of the window.
3.  Click Supplies Status.
The estimated ink levels appear.

4. Click All Settings to return to the Information and Support pane.

[%F NOTE: If you have installed a refilled or remanufactured ink cartridge, or an ink cartridge that has been used
in another printer, the ink level indicator might be inaccurate or unavailable.

[%’/r NOTE: Ink level warnings and indicators provide estimates for planning purposes only. When you receive a
low-ink warning message, consider having a replacement ink cartridge available to avoid possible printing
delays. You do not have to replace the ink cartridges until the print quality is unacceptable.

[%)/]" NOTE: Ink from the ink cartridges is used in the printing process in a number of different ways, including in
the initialization process, which prepares the printer and cartridges for printing, and in printhead servicing,
which keeps print nozzles clear and ink flowing smoothly. In addition, some residual ink is left in the ink
cartridge after it is used. For more information, see www.hp.com/go/inkusage.
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Order ink supplies

Before ordering cartridges, locate the correct cartridge number.

To locate the cartridge number on the printer

e  The cartridge number is located inside the cartridge access door.

To locate the cartridge number from the printer software (Windows)

1.  Open the HP printer software. For more information, see Open the HP printer software (Windows)
onpage 17.

2. Inthe printer software, click Shop, click Shop For Supplies Online, and then follow the on-screen
instructions.

To find the print cartridge reorder numbers (0S X)
1.  Open HP Utility.

[’_ﬁ”f NOTE: HP Utility is located in the Hewlett-Packard folder in the Applications folder at the top level of
the hard disk.

2.  Click Supplies Info.
The print cartridge ordering numbers appear.
3.  Click All Settings to return to the Information and Support pane.

To order original HP supplies for the HP DeskJet 2130 series, go to www.hp.com/buy/supplies . If prompted,
choose your country/region, and then follow the prompts to find the right cartridges for your printer.

[Z?’”r NOTE: Ordering ink cartridges online is not supported in all countries/regions. If it is not available in your
country/region, you may still view supplies information and print a list for reference when shopping at a local
HP reseller.
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Replace ink cartridges

To replace the ink cartridges
1.  Check that power is on.
2. Remove theink cartridge.

a. Open the cartridge access door and wait for the print carriage to move to the center of the printer.

Press down to release the ink cartridge, and then remove it from the slot.

&

3. Insert anew ink cartridge.

a. Remove theink cartridge from the packaging.

X
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Remove the plastic tape using the pull tab.

©

[2?9 NOTE: Do not touch the electrical contacts on the ink cartridge.

¢. Slide the ink cartridge into the slot until it clicks into place.

d. Close the cartridge access door.

[%r NOTE: The HP printer software prompts you to align the ink cartridges when you print a

document after installing the new ink cartridge.

Replace ink cartridges
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Use single-cartridge mode

Use the single-cartridge mode to operate the printer with only one ink cartridge. The single-cartridge mode is
initiated when an ink cartridge is removed from the ink cartridge carriage.

[%’ NOTE: When the printer operates in single-cartridge mode, a message is displayed on the computer screen.
If the message is displayed and two ink cartridges are installed in the printer, verify that the protective piece
of plastic tape has been removed from each ink cartridge. When the plastic tape covers the ink cartridge
contacts, the printer cannot detect that the ink cartridge is installed. If there is no plastic tape on the
cartridges, try cleaning the cartridge contacts. For information about cleaning ink cartridge contacts, see Ink
cartridge issues on page 54.

To exit the single-cartridge mode

e Install both the black and tri-color ink cartridges in the printer.
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Cartridge warranty information

ENWW

The HP cartridge warranty is applicable when the cartridge is used in its designated HP printing device. This
warranty does not cover HP ink cartridges that have been refilled, remanufactured, refurbished, misused, or
tampered with.

During the warranty period, the cartridge is covered as long as the HP ink is not depleted and the end of
warranty date has not been reached. The end of warranty date, in YYYY/MM/DD format, may be found on the
cartridge as indicated:

For a copy of the HP Limited Warranty Statement, see the printed documentation that came with the printer.

Cartridge warranty information
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Tips for working with cartridges

Use the following tips to work with cartridges:

To protect the cartridges from drying out, always turn the printer off using the Power button, and wait
until the Power button light goes out.

Do not open or untape cartridges until you are ready to install them. Leaving tape on the cartridges
reduces ink evaporation.

Insert the cartridges into the correct slots. Match the color and icon of each cartridge to the color and
icon for each slot. Make sure the cartridges snap into place.

Align the printer for best print quality. See Printing issues on page 56 for more information.

When the Estimated Ink Levels screen shows one or both cartridges in a low state, consider getting
replacement cartridges to avoid possible printing delays. You do not need to replace the cartridges until
print quality becomes unacceptable. See Replace ink cartridges on page 40 for more information.

If you remove a cartridge from the printer for any reason, try to replace it again as soon as possible.
Outside of the printer, if unprotected, cartridges begin to dry out.
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Connect your printer

° Connect your printer to your computer with a USB cable (non-network connection)

° Connect a new printer
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Connect your printer to your computer with a USB cable (non-
network connection)

The printer supports a rear USB 2.0 High Speed port for connection to a computer.

To connect the printer with the USB cable

1. Insert the printer software CD in the computer CD-ROM drive.

9

E NOTE: Do not connect the USB cable to the printer until you are prompted to do so.

2. Follow the on-screen instructions. When you are prompted, connect the printer to the computer by
selecting USB on the Connection Options screen.

3. Follow the on-screen instructions.

If the printer software has been installed, the printer will operate as a plug-and-play device. If the software
has not been installed, insert the CD that came with the printer and follow the on-screen instructions.
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Connect a new printer

If you have not connected the printer to your computer, or you want to connect another new printer of the
same model to your computer, you can use the following instructions to set up the connection.

EY NOTE: Use this method if you have already installed the printer software.

To connect a new printer (Windows)

1.  Open the printer software. For more information, see Open the HP printer software (Windows)
on page 17.

2. Inthe printer software, click Utilities.
3. Select Printer Setup & Software.

4. Select Connect a new printer. Follow the on-screen instructions.

To connect a new printer (0S X)
1. Open System Preferences .

2. Depending on your operating system, click Print & Fax, Print & Scan, or Printers & Scanners in the
Hardware section.

3. Click + below the list of printers at the left.

4. Select the new printer from the list.
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Solve a problem

This section contains the following topics:

Jams and paper-feed issues

Ink cartridge issues

Printing issues

Copy issues

Scan issues

Printer hardware issues

HP support
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Jams and paper-feed issues

What do you want to do?

Clear a paper jam

Solve paper jam issues. Use an HP online troubleshooting wizard

Instructions for clearing paper jams and resolving issues with paper or the paper feed.

[%r NOTE: The HP online troubleshooting wizards may not be available in all languages.

Read general instructions in the Help for clearing paper jams

Paper jams can occur in several locations.

To clear a paper jam from the input tray

1. Press the Cancel button (X) to try to clear the jam automatically. If this does not work, complete the
following steps to clear the jam manually.

2. Pull the paper gently out of the input tray.

3. Make sure thereis no foreign object in the paper path, and then reload paper.

Ej?qy NOTE: Theinput tray shield can prevent foreign debris from falling into the paper path and causing
serious paper jams. Do not take down the input tray shield.

4. Press the Resume button (m) on the control panel to continue the current job.

To clear a paper jam from the output tray

1. Press the Cancel button (X) to try to clear the jam automatically. If this does not work, complete the
following steps to clear the jam manually.
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2.  Pull the paper gently out of the output tray.

3. Press the Resume button (@) on the control panel to continue the current job.

To clear a paper jam from the cartridge access area

1. Press the Cancel button (X) to try to clear the jam automatically. If this does not work, complete the
following steps to clear the jam manually.

2. Remove the jammed paper.
3. Ppress the Power button ((D) to turn off the printer.

b. Open the cartridge access door.

¢. If the print carriage is in the center of the printer, slide it to the right.

d. Remove the jammed paper.

e. Close the cartridge access door.

3. Press the Power button (d)) to turn on the printer.
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To clear a paper jam inside of the printer

1. Press the Cancel button () to try to clear the jam automatically. If this does not work, complete the
following steps to clear the jam manually.

2. Press the Power button ((D) to turn off the printer.

3.  Turn the printer over, locate the cleanout door on the bottom of the printer, and then pull both tabs on
the cleanout door to open it.

4. Remove the jammed paper.

5. Close the cleanout door. Gently push the door towards the printer until both latches snap into place.

6. Turnthe printer over, and then press the Power button (d)) to turn on the printer.

Clear a print carriage jam

Resolve a print carriage jam. Use an HP online troubleshooting wizard

If something is blocking the print carriage or it does not move easily, get step-by-step instructions.

[%’/]’9 NOTE: The HP online troubleshooting wizards may not be available in all languages.

Read general instructions in the Help for clearing a print carriage jams

A Remove any objects, such as paper, that are blocking the print carriage.
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[%f NOTE: Do not use any tools or other devices to remove jammed paper. Always use caution when

removing jammed paper from inside the printer.

Learn how to avoid paper jams

To help avoid paper jams, follow these guidelines.

Do not overfill the input tray.
Remove printed papers from the output tray frequently.
Ensure that paper loaded in the input tray lays flat, and the edges are not bent or torn.

Do not combine different paper types and paper sizes in the input tray; the entire stack of paper in the
input tray must be the same size and type.

Adjust the paper-width guide in the input tray to fit snugly against all paper. Make sure the paper-width
guide does not bend the paper in the input tray.

Do not force paper too far down in the input tray.

Do not add paper while the printer is printing. If the printer is about to run out of paper, wait until the out
of paper message appears before adding paper.

Solve paper-feed problems

ENWW

What kind of problem are you having?

Paper is not picked up from the input tray

— Make sure paper is loaded in the input tray. For more information, see Load media on page 10.

— Adjust the paper-width guide in the input tray to fit snugly against all paper. Make sure the paper-
width guide does not bend the paper in the input tray.

— Make sure paper in the input tray is not curled. Uncurl paper by bending it in the opposite direction
of the curl.

Pages are skewing

— Make sure the paper is loaded in the far-right side of the input tray and the paper-width guide is fit
against the left side of the paper.

— Load paper into the printer only when it is not printing.
Multiple pages are being picked up

— Adjust the paper-width guide in the input tray to fit snugly against all paper. Make sure the paper-
width guide does not bend the paper in the input tray.

— Make sure the input tray is not overloaded with paper.
— Make sure the pieces of the loaded paper are not sticking together.

— Use HP paper for optimum performance and efficiency.

Jams and paper-feed issues
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Ink cartridge issues

Identify whether an ink cartridge has a problem

To identify whether an ink cartridge has a problem, check the status of the corresponding Ink Alert light on
the printer control panel. For more information, see Status lights on page 6.

If you get an ink cartridge problem message from the printer software that states at least one of the
cartridges has a problem, do the following to identify whether a cartridge has a problem.

1.  Remove the black cartridge and then close the cartridge access door.
o [f the Ink Alert light for the tri-color cartridge blinks, the tri-color cartridge has a problem.

o If the Ink Alert light for the tri-color cartridge does not blink, the tri-color cartridge does not have
aproblem.

2. Install the black cartridge back in the printer, remove tri-color cartridge, and then close the cartridge
access door.

o If the Ink Alert light for the black cartridge blinks, the black cartridge has a problem.

o [f the Ink Alert light for the black cartridge does not blink, the black cartridge does not have a
problem.

Fix ink cartridge problems

If an error occurs after a cartridge is installed, or if a message indicates a cartridge problem, try removing the
ink cartridges, verifying the protective piece of plastic tape has been removed from each ink cartridge, and
then reinserting the ink cartridges. If this does not work, clean the cartridge contacts. If the problem is still
not resolved, replace the ink cartridges. For information about replacing ink cartridges, see Replace ink
cartridges on page 40.

To clean cartridge contacts

A CAUTION: The cleaning procedure should take only a few minutes. Make sure that the ink cartridges are
reinstalled in the printer as soon as possible. It is not recommended to leave the ink cartridges outside of the
printer longer than 30 minutes. This could result in damage to the printhead or the ink cartridges.

1.  Check that poweris on.

2. Open the cartridge access door and wait for the print carriage to move to the center of the printer.
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3. Remove theink cartridge indicated in the error message.

4. Clean the cartridge contacts and printer contacts.

a. Hold the ink cartridge by its sides with the bottom pointing up and locate the electrical contacts on
the ink cartridge.

The electrical contacts are the small gold-colored dots on the ink cartridge.

b. Wipe only the contacts with a dry swab or lint-free cloth.

A CAUTION: Be careful to wipe only the contacts, and do not smear any of the ink or other debris
elsewhere on the ink cartridge.

¢. Ontheinside of the printer, locate the contacts for the cartridge.

The printer contacts are the set of gold-colored bumps positioned to meet the contacts on the ink
cartridge.

d. Useadryswab or lint-free cloth to wipe the contacts.
5. Reinstall the ink cartridge.
6. Close the cartridge access door.

7. Checkif the error message has gone away. If you still receive the error message, turn the printer off, and
then on.

[Z?’”r NOTE: If oneink cartridge is causing problems, you can remove it and use the single-cartridge mode to
operate the printer with only one ink cartridge.

Fix ink cartridge incompatible issues

The ink cartridge is not compatible with your printer. Replace it with a new ink cartridge. For more
information, see Replace ink cartridges on page 40.
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Printing issues

What do you want to do?

Fix problems with page not printing (unable to print)

HP Print and Scan Doctor The HP Print and Scan Doctor is a utility that will try to diagnose and fix the issue automatically.

NOTE: This utility is only available for Windows operation system.

Troubleshoot problems with Use an HP online troubleshooting wizard
print jobs not printing.

Get step-by-step instructions if the printer is not responding or printing.

[%’/]’9 NOTE: The HP Print and Scan Doctor and the HP online troubleshooting wizards may not be available in all
languages.

Read general instructions in the Help for unable to print issues

To resolve print issues (Windows)

Make sure that the printer is turned on and that there is paper in the input tray. If you are still unable to print,
try the following in order:

1.  Check for error messages from the printer software and resolve them by following the on-screen
instructions.

2. Disconnect and reconnect the USB cable.

3. Verify that the printer is not paused or offline.

To verify that the printer is not paused or offline
a. Depending upon your operating system, do one of the following:

e  Windows 8.1 and Windows 8: Point to or tap the upper-right corner of the screen to open the
Charms bar, click the Settings icon, click or tap Control Panel, and then click or tap View
devices and printers.

e  Windows 7: From the Windows Start menu, click Devices and Printers.
° Windows Vista: From the Windows Start menu, click Control Panel, and then click Printers.

e  Windows XP: From the Windows Start menu, click Control Panel, and then click Printers and
Faxes.

b. Either double-click the icon for your printer or right-click the icon for your printer and select See
what's printing to open the print queue.

¢.  Onthe Printer menu, make sure there are no check marks next to Pause Printing or Use Printer
Offline.

d. If you made any changes, try to print again.

4. Verify that the printer is set as the default printer.
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To verify that the printer is set as the default printer

d.

Depending upon your operating system, do one of the following:

e  Windows 8.1 and Windows 8: Point to or tap the upper-right corner of the screen to open the
Charms bar, click the Settings icon, click or tap Control Panel, and then click or tap View
devices and printers.

. Windows 7: From the Windows Start menu, click Devices and Printers.
° Windows Vista: From the Windows Start menu, click Control Panel, and then click Printers.

e  Windows XP: From the Windows Start menu, click Control Panel, and then click Printers and
Faxes.

Make sure the correct printer is set as the default printer.
The default printer has a check mark in a black or green circle next to it.

If the wrong printer is set as the default printer, right-click the correct printer and select Set as
Default Printer.

Try using your printer again.

5. Restart the print spooler.

To restart the print spooler

Depending upon your operating system, do one of the following:

Windows 8.1 and Windows 8

i.  Point to or tap the upper-right corner of the screen to open the Charms bar, and then click the
Settings icon.

ii.  Click or tap Control Panel, and then click or tap System and Security.
iii. Click or tap Administrative Tools, and then double-click or double-tap Services.
iv. Right-click or touch and hold Print Spooler, and then click Properties.
v. Onthe General tab, next to Startup type, make sure that Automatic is selected.

vi. If the service is not already running, under Service status, click or tap Start, and then click or
tap OK.

Windows 7

i.  From the Windows Start menu, click Control Panel, System and Security, and then
Administrative Tools.

ii. Double-click Services.
iii. Right-click the Print Spooler, and then click Properties.
iv. Onthe General tab, next to Startup type, make sure that Automatic is selected.

v. If the serviceis not already running, under Service status, click Start, and then click OK.
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Windows Vista

i.  From the Windows Start menu, click Control Panel, System and Maintenance,
Administrative Tools.

ii. Double-click Services.
iii. Right-click the Print Spooler service, and then click Properties.
iv. Onthe General tab, next to Startup type, make sure that Automatic is selected.

v. Iftheserviceis not already running, under Service status, click Start, and then click OK.

Windows XP

i.  From the Windows Start menu, right click My Computer.

ii.  Click Manage, and then click Services and Applications.

iii. Double-click Services, and then select Print Spooler.

iv. Right-click Print Spooler, and click Restart to restart the service.
b. Make sure the correct printer is set as the default printer.

The default printer has a check mark in a black or green circle next to it.

¢. Ifthe wrong printer is set as the default printer, right-click the correct printer and select Set as
Default Printer.

d. Tryusing your printer again.
6. Restart the computer.

7. Clear the print queue.

To clear the print queue
a. Depending upon your operating system, do one of the following:

e  Windows 8.1 and Windows 8: Point to or tap the upper-right corner of the screen to open the
Charms bar, click the Settings icon, click or tap Control Panel, and then click or tap View
devices and printers.

° Windows 7: From the Windows Start menu, click Devices and Printers.
e  Windows Vista: From the Windows Start menu, click Control Panel, and then click Printers.

° Windows XP: From the Windows Start menu, click Control Panel, and then click Printers and
Faxes.

b. Double-click the icon for your printer to open the print queue.

¢.  Onthe Printer menu, click Cancel all documents or Purge Print Document, and then click Yes to
confirm.

d. If there are still documents in the queue, restart the computer and try printing again after the
computer has restarted.

e. Check the print queue again to make sure it is clear, and then try to print again.
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To resolve print issues (0S X)
1. Check for error messages and resolve.
2. Disconnect and reconnect the USB cable.

3. Verify that the product is not paused or offline.

To verify that the product is not paused or offline
a. InSystem Preferences, click Print & Fax.
b. Click the Open Print Queue button.
¢. Click a print job to select it.
Use the following buttons to manage the print job:
e  Delete: Cancel the selected print job.
e  Hold: Pause the selected print job.
e  Resume: Continue a paused print job.
e  Pause Printer: Pause all print jobs in the print queue.
d. If you made any changes, try to print again.

4. Restart the computer.

Fix print quality issues

Step-by-step instructions for resolving most print quality issues. Troubleshoot print quality issues online

Read general instructions in the Help for resolving print quality issues

[Z?’”r NOTE: To protect the cartridges from drying out, always turn the printer off using the Power button, and
wait until the Power button light goes out.

To improve print quality (Windows)
1. Make sure you are using original HP ink cartridges.

2. Check the printer software to make sure you have selected the appropriate paper type from the Media
drop-down list and print quality from the Quality Settings drop-down list.

In the printer software, click Print & Scan and then click Set Preferences to access the print properties.
3. Check the estimated ink levels to determine if the ink cartridges are low on ink.

For more information, see Check estimated ink levels on page 38. If the ink cartridges are low on ink
consider replacing them.

4. Check the paper type.

For best print quality, use high quality HP paper, or papers that adhere to the ColorLok® standard. For
more information, see Paper basics on page 15.
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Always make sure the paper you are printing on is flat. For best results when printing images, use HP
Advanced Photo Paper.

Store specialty paper in its original packaging inside a resealable plastic bag on a flat surface in a cool,
dry place. When you are ready to print, remove only the paper you plan to use immediately. When you
have finished printing, return any unused photo paper to the plastic bag. This prevents the photo paper
from curling.

5.  Align the ink cartridges.

To align the ink cartridges
a. Load letter or A4 unused plain white paper into the input tray.

b. Open the printer software. For more information, see Open the HP printer software (Windows)
on page 17.

¢. Inthe printer software, click Print & Scan and then click Maintain Your Printer to access the
printer toolbox.

The printer toolbox appears.
d. Click Align Ink Cartridges on the Device Services tab.
The printer prints an alignment page.

e. Follow the on-screen instructions to load the cartridge alignment page print side down on the
scanner glass, and then click Scan to scan the alignment page.

The printer aligns the ink cartridges. Recycle or discard the cartridge alignment sheet.
6. Print a diagnostics page if the ink cartridges are not low on ink.
To print a diagnostics page
a. Load letter or A4 unused plain white paper into the input tray.

b. Open the printer software. For more information, see Open the HP printer software (Windows)
on page 17.

¢. Inthe printer software, click Print & Scan and then click Maintain Your Printer to access the
printer toolbox.

d. Click Print Diagnostic Information on the Device Reports tab to print a diagnostics page.
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7. Clean theink cartridges, if the diagnostic page shows steaks or missing portions of the color and black

Review the blue, magenta, yellow, and black boxes on the diagnostics page.
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To clean the ink cartridges

d.

Load letter or A4 unused plain white paper into the input tray.

Open the printer software. For more information, see Open the HP printer software (Windows)
on page 17.

In the printer software, click Print & Scan and then click Maintain Your Printer to access the
Printer Toolbox.

Click Clean Ink Cartridges on the Device Services tab. Follow the on-screen instructions.

To improve print quality (0S X)

1.  Make sure you are using original HP cartridges.

2. Make sure you have selected the appropriate paper type and print quality in the Print dialog.

3. Check the estimated ink levels to determine if the cartridges are low on ink.

Consider replacing the print cartridges if they are low on ink.
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4. Check the paper type.

For best print quality, use high quality HP paper, or papers that adhere to the ColorLok® standard. For
more information, see Paper basics on page 15.

Always make sure the paper you are printing on is flat. For best results when printing images, use HP
Advanced Photo Paper.

Store specialty paper in its original packaging inside a resealable plastic bag on a flat surface in a cool,
dry place. When you are ready to print, remove only the paper you plan to use immediately. When you
have finished printing, return any unused photo paper to the plastic bag. This prevents the photo paper
from curling.

5.  Align the printer cartridges.

To align print cartridges from the software
a. Load Letter or A4 plain, white paper in the paper tray.

b. Open HP Utility.

[’_ﬁ”r NOTE: HP Utility is located in the Hewlett-Packard folder in the Applications folder at the top
level of the hard disk.

¢.  Select the HP DeskJet 2130 series from the list of devices at the left of the window.
d. Click Align.

e. Click Align and follow the on-screen instructions.

f.  Click All Settings to return to the Information and Support pane.

6. Print a test page.

To print a test page
a. Load Letter or A4 plain, white paper in the paper tray.
b. Open HP Utility.

[%i’ NOTE: HP Utility is located in the Hewlett-Packard folder in the Applications folder at the top
level of the hard disk.

c. Select the HP DesklJet 2130 series from the list of devices at the left of the window.
d. Click Test Page.
e. Click the Print Test Page button, and follow the on-screen instructions.

Check the test page for jagged lines in the text or streaks in the text and colored boxes. If you are
seeing jagged lines, or streaks, or no ink in portions of the boxes, then automatically clean the
cartridges.

7. If the diagnostic page shows steaks or missing portions of the text or colored boxes, clean the print
cartridges automatically.
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To automatically clean the print head
a. Load Letter or A4 plain, white paper in the paper tray.
b. Open HP Utility.

[1-7;?9 NOTE: HP Utility is located in the Hewlett-Packard folder in the Applications folder at the top
level of the hard disk.

c. Select the HP DeskJet 2130 series from the list of devices at the left of the window.
d. Click Clean Printheads.

e. Click Clean, and follow the on-screen instructions.

A CAUTION: Clean the print head only when necessary. Unnecessary cleaning wastes ink and
shortens the life of the print head.

[17? NOTE: If print quality still seems poor after you complete cleaning, try aligning the printer. If
print quality problems persist after cleaning and aligning, contact HP support.

f.  Click All Settings to return to the Information and Support pane.
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Copy issues

Troubleshoot copy problems. | Use an HP online troubleshooting wizard

Get step-by-step instructions if the printer does not create a copy, or if your printouts are low quality.

99

= NOTE: The HP online troubleshooting wizards may not be available in all languages.

Tips for copy and scan success on page 36

64 Chapter 7 Solve a problem ENWW


http://h20180.www2.hp.com/apps/Nav?h_pagetype=s-924&h_client=s-h-e004-01&h_keyword=lp70034-all-DJ2130&h_lang=en&h_cc=us

Scan issues

HP Print and Scan The HP Print and Scan Doctor is a utility that will try to diagnose and fix the issue automatically.
Doctor
NOTE: This utility is only available for Windows operation system.

Solve scan problems Use an HP online troubleshooting wizard

Get step-by-step instructions if you cannot create a scan or if your scans are low quality.

[%”f NOTE: The HP Print and Scan Doctor and the HP online troubleshooting wizards may not be available in all
languages.

Tips for copy and scan success on page 36
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Printer hardware issues

Close cartridge access door

e  (artridge door must be closed to begin printing.

The printer shuts down unexpectedly
e  (Check the power and power connections.

e  Make sure the printer's power cord is connected firmly to a functioning power outlet.

[%9 NOTE: When Auto-0ff is enabled, the printer will automatically turn off after 2 hours of inactivity to help
reduce energy use. For more information, see Auto-Off on page 19.

Resolve printer failure

e  Turn the printer off, then on. If that does not resolve the problem, contact HP.
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HP support

For the latest product updates and support information, visit the HP DeskJet 2130 series support website at
www.hp.com/support. HP online support provides a variety of options for help with your printer:

Drivers & downloads: Download software drivers and updates, as well as product manuals and documentation
that came in the box with your printer.
HP support forums: Visit HP Support Forums for answers to common questions and issues. You can view
questions posted by other HP customers, or sign in and post your own questions and comments.
A 1 Troubleshooting: Use HP online tools to detect your printer and find recommended solutions.
Contact HP

If you need help from an HP technical support representative to solve a problem, visit the Contact Support
website. The following contact options are available at no cost for in-warranty customers (HP agent-assisted
support for out-of warranty customers may require a fee):

Chat with an HP support agent online.

& Call an HP support agent.

When contacting HP support, be prepared to provide the following information:
e  Product name (Located on the printer, such as HP DeskJet 2130)

e  Product number (located inside the cartridge access door)

e  Serial number (located on the back or bottom of the printer)

Register printer

By taking just a few quick minutes to register, you can enjoy quicker service, more efficient support, and
product support alerts. If you did not register your printer while installing the software, you can register now
at http://www.register.hp.com.
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Additional warranty options

Extended service plans are available for the HP DeskJet 2130 series at additional costs. Go to www.hp.com/
support, select your country/region and language, then explore the extended warranty options available for
your printer.
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Technical information

The technical specifications and international regulatory information for the HP DeskJet 2130 series are
provided in this section.

For additional specifications, see the printed documentation that came with the HP DeskJet 2130 series.
This section contains the following topics:

° Hewlett-Packard Company notices

e  Specifications

° Environmental product stewardship program

° Requlatory notices
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Hewlett-Packard Company notices

The information contained herein is subject to change without notice.

All rights reserved. Reproduction, adaptation, or translation of this material is prohibited without prior
written permission of Hewlett-Packard, except as allowed under the copyright laws. The only warranties for
HP products and services are set forth in the express warranty statements accompanying such products and
services. Nothing herein should be construed as constituting an additional warranty. HP shall not be liable for
technical or editorial errors or omissions contained herein.

© 2014 HP Development Company, L.P.

Microsoft®, Windows ®, Windows® XP, Windows Vista®, Windows® 7, Windows® 8, and Windows® 8.1 are U.S.
registered trademarks of Microsoft Corporation.
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Specifications

Technical specifications for the HP DeskJet 2130 series are provided in this section. For more product
specifications, see the Product Data Sheet at www.hp.com/support .

System requirements

Software and system requirements can be found in the Readme file, which is available on the HP printer
software CD provided with your printer.

For information about future operating system releases and support, visit the HP online support website
at www.hp.com/support .

Environmental specifications

Recommended operating temperature range: 15°C to 302C (59°F to 86°F)
Allowable operating temperature range: 52C to 402C (41°F to 104°F)
Humidity: 15% to 80% RH non-condensing; 282C maximum dewpoint
Nonoperating (Storage) temperature range: —40°C to 60°C (—40°F to 140°F)

In the presence of high electromagnetic fields, it is possible the output from the HP DeskJet 2130 series
may be slightly distorted

HP recommends using a USB cable less than or equal to 3 m (10 feet) in length to minimize injected
noise due to potential high electromagnetic fields

Input tray capacity

Plain paper sheets (80 g/m2 [20lb]): Up to 60
Envelopes: Up to 5
Index cards: Up to 20

Photo paper sheets: Up to 20

Output tray capacity

Paper size

Paper weights

ENWW

Plain paper sheets (80 g/m2 [20lb]): Up to 25
Envelopes: Up to 5
Index cards: Up to 10

Photo paper sheets: Up to 10

For a complete list of supported media sizes, see the printer software.

Plain Paper: 64 to 90 g/m?2 (16 to 24 lb)

Envelopes: 75 to 90 g/m2 (20 to 24 lb)

Specifications
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e  (ards: Up to 200 g/m2 (110-Ib index maximum)
e  Photo Paper: Up to 280 g/m?2 (75 lb)

Print specifications

e  Print speeds vary according to the complexity of the document
e  Method: drop-on-demand thermal inkjet

e  Language: PCL3 GUI

Copy specifications
e Digital image processing

° Copy speeds vary according to the complexity of the document and model

Scan specifications
e  Resolution: up to 1200 x 1200 ppi optical
For more information about ppi resolution, see the scanner software.
e  C(olor: 24-bit color, 8-bit grayscale (256 levels of gray)

e Maximum scan size from glass: 21.6 x 29.7 cm (8.5 x 11.7 inches)

Print resolution

e  Foralist of supported print resolutions, visit the HP DeskJet 2130 series support website at

www.hp.com/support.

Cartridge yield

e  Visit www.hp.com/go/learnaboutsupplies for more information on estimated cartridge yields.

Acoustic information

e If you have Internet access, you can access acoustic information from the HP website.
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Environmental product stewardship program

Hewlett-Packard is committed to providing quality products in an environmentally sound manner. Design for
recycling has been incorporated into this product. The number of materials has been kept to a minimum while
ensuring proper functionality and reliability. Dissimilar materials have been designed to separate easily.
Fasteners and other connections are easy to locate, access, and remove using common tools. High priority
parts have been designed to access quickly for efficient disassembly and repair.

For more information, visit HP's Commitment to the Environment Web site at:

www.hp.com/hpinfo/globalcitizenship/environment

° Eco-Tips

° European Union Commission Requlation 1275/2008

° Paper use
° Plastics

° Material safety data sheets

° Recycling program

° HP inkjet supplies recycling program

° Power consumption

° Disposal of waste equipment by users

° Chemical substances

° The Table of Hazardous Substances/Elements and their Content (China)

° Restriction of hazardous substance (Ukraine)

° Restriction of hazardous substance (India)

e  EPEAT

° China SEPA Eco Label User Information

° China Energy Label for Printer, Fax and Copier

Eco-Tips

HP is committed to helping customers reduce their environmental footprint. Please visit the HP
Environmental Programs and Initiatives website for more information on HP’s environmental initiatives.

www.hp.com/hpinfo/globalcitizenship/environment/

European Union Commission Regulation 1275/2008

ENWW

For product power data, including the power consumption of the product in networked standby if all wired
network ports are connected and all wireless network ports are activated, please refer to section P14
‘Additional Information’ of the product IT ECO Declaration at www.hp.com/hpinfo/globalcitizenship/
environment/productdata/itecodesktop-pc.html.

Environmental product stewardship program
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Paper use
This product is suited for the use of recycled paper according to DIN 19309 and EN 12281:2002.

Plastics

Plastic parts over 25 grams are marked according to international standards that enhance the ability to
identify plastics for recycling purposes at the end of product life.

Material safety data sheets
Material safety data sheets (MSDS) can be obtained from the HP website at:

www.hp.com/go/msds

Recycling program

HP offers an increasing number of product return and recycling programs in many countries/regions, and
partners with some of the largest electronic recycling centers throughout the world. HP conserves resources
by reselling some of its most popular products. For more information regarding recycling of HP products,
please visit:

www.hp.com/hpinfo/globalcitizenship/environment/recycle/

HP inkjet supplies recycling program

HP is committed to protecting the environment. The HP Inkjet Supplies Recycling Program is available in
many countries/regions, and lets you recycle used print cartridges and ink cartridges free of charge. For more
information, go to the following website:

www.hp.com/hpinfo/globalcitizenship/environment/recycle/

Power consumption

Hewlett-Packard printing and imaging equipment marked with the ENERGY STAR® logo is qualified to the U.S.
Environmental Protection Agency’s ENERGY STAR specifications for imaging equipment. The following mark
will appear on ENERGY STAR qualified imaging products:

ENERGY STAR

Additional ENERGY STAR qualified imaging product model information is listed at: www.hp.com/go/energystar
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Disposal of waste equipment by users

This symbol means do not dispose of your product with your other household waste. Instead,
you should protect human health and the environment by handing over your waste
equipment to a designated collection point for the recycling of waste electrical and electronic
equipment. For more information, please contact your household waste disposal service, or

go to http://www.hp.com/recycle.

Chemical substances

The Table of Hazardous Substances/Elements and their Content (China)

ENWW

HP is committed to providing our customers with information about the chemical substances in our products
as needed to comply with legal requirements such as REACH (Regulation EC No 1907/2006 of the European

Parliament and the Council). A chemical information report for this product can be found at: www.hp.com/go/

reach.
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Restriction of hazardous substance (Ukraine)

TexHi4HMIK pernameHT Wopo oOMmerKeHHS BUKOPUCTAHHA
HebeineuyHux pe4oeuH (YkpaiHa)

O6nagHaxks signosinae sumoram TEXHIMHOTO PEIMAaMEHTY LOAC OBMEXEHHI BHKOPHMCTAHHS
[EeSKHX HEBE3NEUHHX PEYOBHH B ENEKTPHYHOMY Ta ENEKTPOHHOMY OONQIHAHHI,
sateepprkexoro noctanosoio Kabikery Minictpie Ykpaium sig 3 rpynxs 2008 Ne 1057

Restriction of hazardous substance (India)

Restriction of hazardous substances (India)

This product complies with the "India E-waste (Mancgement and Handling) Rule 2011" and
prehibits use of lead, mercury, hexavalent chromivm, polybrominated biphenyls or
pelybrominated diphenyl ethers in concentrations exceeding 0.1 weight % and 0.01 weight
% for cadmium, axcept for the exemptions set in Schedule 2 of the Ruls.

EPEAT

EPEAT

Most HP products are designed to meet EPEAT. EPEAT is a comprehensive
environmental rating that helps identify greener electronics equipment. For more
information on EPEAT go to www.epeat.net. For information on HP's EPEAT
registered products go to
www.hp.com/hpinfo/globalcitizenshipfenvironment/pdf/epeat_printers.pdf.

China SEPA Eco Label User Information
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China Energy Label for Printer, Fax and Copier
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Regulatory notices
The HP DeskJet 2130 series meets product requirements from regulatory agencies in your country/region.
This section contains the following topics:

° Requlatory model identification number

° FCC statement

° Notice to users in Korea

° V/CCI (Class B) compliance statement for users in Japan

° Notice to users in Japan about the power cord

° Noise emission statement for Germany

° Visual display workplaces statement for Germany

° European Union Requlatory Notice

° Declaration of conformity

Regulatory model identification number

For regulatory identification purposes, your product is assigned a Regulatory Model Number. The Regulatory
Model Number for your product is SNPRH-1504-01. This regulatory number should not be confused with the
marketing name (HP DeskJet 2130 All-in-One Printer, HP DeskJet Ink Advantage 2135 All-in-One Printer, etc.)
or product numbers (F5S28A, F5528B, F5528C, F5528D, F5529A, F5529B, F5529C, etc.).
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FCC statement

FCC statement

The United Stotes Federal Communicafions Commission (in 47 CFR 15.105) hes specified
that the fellowing nofice be brought to the attention of usars of this prodwct.

This equipment has been tested and found to comply with the limits for a Class B digital
devica, pursuant to Part 15 of the FCC Rules. These limits are designed to provida reason-
able profecfion ogainst harmful inferference in o residential installafion. This equipment
generates, uses and can rodiate radic frequency energy and, if not instolled and used in
accordance with the insiruchions, may couse harmful interference to radio communicaficns.
However, there is no guarantee that interferance will not occur in a particular installation.
I this equipment does cavse harmbul inferfersnce to radic or television receplion, which can
be determined by tuming the equipment off and on, the user is encouraged fo fry fo comect
the interference by one or more of the following measures:
- Recrent or relocate the receiving anfenna.

Increase the separafion behween the equipment and the recaiver.

Connect the equipment info an oullst on o crcuit different from that to which the

receiver is conn

Consult the dealer or an experianced radic/TV technician for halp.
For further information, contact:

Manager of Corporate Product Regulations

Hewlett-Packard Company

3000 Hanover Sirest

Palo Alto, Ca 94304

(&50) 8571501
Madifications (part 15.21)

The FCC requires the user to be notified that any changes or medifications made to this
devica that are not expressly approved by HP may void the vser's authority to operate the
equipment.

This device complies with Part 15 of the FCC Rules. Operation is subject fo the following
two conditions: (1) this device may not cause harmful interference, and (2] this device must
accept any inferference received, including intederence thot may couse undesired

operation.

Notice to users in Korea
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VCCI (Class B) compliance statement for users in Japan
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Notice to users in Japan about the power cord
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Noise emission statement for Germany

Gerauschemission
lpA = 70 dB am Arhﬂifsphlz im Mormalbeinieb noch DIM 45535 T 19

Visual display workplaces statement for Germany

G5-Erklérung (Dovtschland)

Dras Gt ist picht for die Bemutzeng im ermiftelboren Gesichiskdd om Bildschi
vorgasahan. Um sorendo Roflaxicnen am Bildschirmarbailsplofz 2w vermeidan, dart dicses Prnd!.H'
richt im enmitelboran Gesichisleld plotzicet wardan.

European Union Regulatory Notice

C€

Products bearing the CE marking comply with one or more of the following EU Directives as may be
applicable: Low Voltage Directive 2006/95/EC, EMC Directive 2004/108/EC, Ecodesign Directive 2009/125/EC,
R&TTE Directive 1999/5/EC, RoHS Directive 2011/65/EU. Compliance with these directives is assessed using
applicable European Harmonised Standards. The full Declaration of Conformity can be found at the following
website: www.hp.com/go/certificates (Search with the product model name or its Regulatory Model Number
(RMN), which may be found on the regulatory label.)

The point of contact for regulatory matters is:

Hewlett-Packard GmbH, Dept./MS: HQ-TRE, Herrenberger Strasse 140, 71034 Boeblingen, GERMANY
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Declaration of conformity

ENWW

(] DECLARATION OF CONFORMITY
according 1o ISONEC 17050-1 and EN 17050-1

DoC #: SNPRH-1504-01-Rev A
Supplier's Name: Hewlett-Packard Company
Supplier's Address: 20, lia Feng Rood Waigoogios Free Trade Zone Pedong, Shanghai,

declares, that the product FRC 200131
Product Mome and Model: 2)  HPF Desklet 2130 AlkineOne prinler sories

HF Desklel Ink Advanioge 2135 AlkineDne prinler series
Regulatory Model Number: " SHPRH-1504-01

Product Options: All
conforms to the following Product Specifications and Regulations:
EMC:

CISPR X2 EdS 200540 2005«42: 2004 Closs B
Etd S5022: 2004 +a0 2007 Clons B
EM SS024: 1998 + AL2000 « AZ2000
Erd ST000-3- 203006 +A 12000 202000
Er ST000-3-3: 23008
FOD CFR 47 Pard 15 Cles B
BCES-ODT, lssue 4 Class B Class B
Safety:
Etd GOS0 1006 +A1 12009 +41:2010 +A12:2011
BEC ORS00 3005 +A 12009
Er A3479:2010
Energy Use:
Rogulation [EC) Mo, 1275, 2008
EMERGY SIARD Chualified Imaging Equipment Opsrasional Made (O] Test Procedure
EM S05464: 20101
IEC &30 3005
RaHS5:
EM SO5E1:2002
The praduct harewith complios with the requirements of the Low Vollage Directive 200895 /7EC, the EMC
Directive 2004/ 108/EC, the RETTE Directive 1999/5/EC, the Ecodesign Directive 200971 25/EC, the
RaMS Directive 2011/65/EU and corries the CE marking accordingly.
Thiz device complies with pard 15 of the FCC Bules. Operalion is subject o the following bwe condilians:
(1] This device may nol couse harmbul inlerforence, and (2] this device musl occepl any interference recoived,
including inlerference thel may couse undesired operalion.

Additional Information:

1) This product is assigned o Regulalery Medel Mumber which stays with the regulstory aspects of the
design. The Regulatery Madel Mumber is the main product identifier in the regulalory documentalion and
les! reports, this number should nol be confused with the marketing name or the product numbers.

15 Dee, 2014
Shen HongBo
W23 Preduct Hardware Guality Enginecring, Maonoger

Local contact for regulatory topics only:
EL: Hewlett-Packard GmbH, HO-TRE, Herrenberger Strasse 140, 71034 Bocblingen, Germany
U5 HewletPackard, 3000 Hanover 51, Pale Alle, CA 94304, US.A. 650857

1500wy hp.l:'l.l_.-":crl [reate

Regulatory notices
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